
Chapter 2

Getting Started with 
Revit Architecture 

After completing this chapter, you will be able to:
• Start a new project.
• Set units of various measurement parameters for a project.
• Understand the concept of snaps, dimensions, and object snaps.
• Save a project.
• Modify parameters and settings of a project.   
• Close a project and exit Revit Architecture.
• Open an existing project.
• Explore the building model using viewing tools.
• Use the Navigation tools.

Learning Objectives
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In this chapter, as you start learning to create a new building project, you will also learn the 
methods of creating the initial setups such as units, snaps, and others.

Starting a new project

In Autodesk Revit Architecture, a project is considered as a single database that contains all 
information related to building design. As a result, the three-dimensional models drawn using 
this software are called building information models. Starting from geometry to construction 
data, each project file contains the complete information of the building design. 

In Revit Architecture, whenever you start a new project, the new project file uses the default 
settings defined in a project template file called default.rte. To start a new project, choose the 
Application Button; the Application Menu will be displayed. From the Application Menu, 
choose New > Project, as shown in Figure 2-1. On doing so, the New Project dialog box will 
be displayed, as shown in Figure 2-2. Using this dialog box, you can select an existing .rte 
template file format for using in the new project.

Shortcut Keys:	       CTRL+N
Application Menu:  New > Project 

Figure 2-2  The New Project dialog box

Figure 2-1  Choosing the Project option from the cascading menu 
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A template file has various project parameters such as units and views, already saved in it. On 
using it, the new project will adopt the same parameters as the template file. The difference 
between a template file and a project file is that the template files have .rte extension, whereas 
the proje   ct files have a .rvt extension. You can either select any of the template files provided 
in Revit Architecture or create your own file. Any project file can be saved as a template file. 
You can select the file to be used as a template by clicking on the Browse button in the New 
Project dialog box. To create a new project, select the Project radio button and to create a 
template, select the Project template radio button.

Note
If you select the None and Project radio buttons from the Template file and Create New areas, 
respectively, a new project file will be created without a template file, but with the default settings 
of Autodesk Revit Architecture.  

SETTING UNITS

Units are important parameters of a project. While installing Revit 
Architecture 2012, the setup program prompts you to set the default unit as 

Imperial (feet and inches) or Metric (meter). The default selection of units helps you open 
project with the specified/selected unit system whenever you start the project. To set units, 
choose the Project Units tool from the Settings panel; the Project Units dialog box will be 
displayed, as shown in Figure 2-3. Project units are grouped into three disciplines: Common, 
Structural, and Electrical. Each discipline has a set of measurement parameters. You can 
select any of these disciplines from the Discipline drop-down list of this dialog box. In this 
drop-down list, the Common option is selected by default. As a result, various measurement 
parameters such as Length, Area, Volume, Angle, Slope, and Currency will be displayed in 
the Project Units dialog box. The Format column in the dialog box displays the current unit 
format for the corresponding parameter in the Units column. You can preview and select the 
possible digit grouping and decimal separators from the Decimal symbol/digit grouping 
drop-down list located at the lower left corner of the dialog box, refer to Figure 2-3. The 
settings for various measurement options are discussed next. 

Length Unit Setting
In Autodesk Revit Architecture, you can assign a unit for the measurement of length in the 
Project Units dialog box. To do so, click in the Format column corresponding to the Length 
parameter; the Format dialog box will be displayed, as shown in Figure 2-4. This dialog box 
displays different units of length and their settings. You can select the desired unit from the 
Units drop-down list in the dialog box. The options that can be selected from the drop-down 
list are Decimal feet, Feet and fractional inches, Decimal inches, Fractional inches, Meters, 
Centimeters, Millimeters, and Meters and Centimeters. After selecting the desired unit, you 
can specify the rounding value for the selected unit. To do so, select the desired option from 
the Rounding drop-down list in the Format dialog box. Note that by default, the Rounding 
increment edit box in the Format dialog box is inactive. To make it active, select the Decimal 
feet or Decimal inches option from the Units drop-down list and then select Custom from 
the Rounding drop-down list. The default value in the Rounding increment edit box is 1.

Ribbon: 	 Manage > Settings > Project Units        
Shortcut Keys: 	UN



2-4 			               Autodesk Revit Architecture for Architects and Designers
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

You can change the default value by entering a value in this edit box. Similarly, the Units 
symbol drop-down list will be inactive for the Feet and fractional inches, Fractional inches, 
and Meters and Centimeters options in the Units drop-down list. From the Unit symbol 
drop-down list, you can select the measurement symbol that will be added to the unit of length. 
For example, you can select ‘m’ as the measurement symbol after all metric length measurement. 

Figure 2-3  The Project Units dialog box

Figure 2-4  The Format dialog box
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In case you select Feet and Fractional inches from the Units drop-down list in the Format 
dialog box, then you need to select the Suppress spaces check box to remove spaces in the 
dash when a length string is expressed in feet and fractional inches to denote a particular 
measurement.

Area Unit Setting
In the Project Units dialog box, you can assign a unit for measuring area. To do so, click in the 
Format column for the Area parameter; the Format dialog box will be displayed. In this dialog 
box, you can set the unit for measuring area from the Units drop-down list that contains various 
options for units of area such as Square feet, Square meters, acres, and so on. The Square 
feet option is selected by default in this drop-down list, if you select Imperial units at the time 
of installing Revit Architecture. The settings for rounding, rounding increment, and unit 
symbol for the area units can be made from their respective drop-down lists and edit boxes.

Volume and Angle Unit Settings
The units for volume and angle can also be set similar to that of the length and area. You 
can set the unit for the volume measurement by selecting any of the options such as Cubic 
yards, Cubic feet, Cubic meters, Liters, and US gallons from the Units drop-down list in the 
Format dialog box of the Volume parameter. Similarly, you can specify the unit for the angle 
measurement by selecting the required option from the Units drop-down list in the Format 
dialog box of the Angle parameter. You can select either Decimal degrees or Degrees minutes 
seconds from the Units drop-down list for specifying the unit for the angle measurement.

Slope Setting
To specify the unit for the slope measurement, click in the Format column for the Slope 
parameter; the Format dialog box will be displayed. In this dialog box, you can specify the 
desired unit settings by selecting the required option from the Units drop-down list. The Units 
drop-down list contains various options such as Ratio : 12, Ratio :10, Rise / 12”, Rise / 1’-0”, 
Rise / 1000mm, Decimal degrees, and Percentage as the unit of the slope measurement. 
The default option for the Imperial unit setting in the drop-down list is Decimal degrees. 

Currency Setting
In Revit Architecture, you can set the unit for currency as well. You can select different types 
of currency symbols from the Unit symbol drop-down list in the Format dialog box of the 
Currency parameter.

Tip: While selecting a rounding value from the Rounding drop-down list in the Format 
dialog box, you should consider the extent of detailing that may be required for the project 
and then select it. For projects that require too much detailing, a lower rounding value 
may be set. This parameter, however, can be modified at any stage during the project 
development.

Tip: As soon as you change the units and choose the OK button to close the Format dialog 
box, the numbers and units shown for each measurement parameter in the Project Units 
dialog box are modified to the new settings. You can modify their settings and format any 
time during the project.
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Note 
You can only format the display of units as they are represented on the screen or printout using 
the Project Units dialog box. The actual values for these units in the project may be different. 
For example, if you set the wall length rounding to the nearest 1’, the wall may show this rounded 
value, but the actual length of the wall might be in fractional feet.

Snaps Tool

The Snaps tool is one of the most productive tools available while creating and 
editing elements in a building model. This tool represents the ability of the cursor to 
snap or jump to the preset increments or specific object properties of various elements 
such as endpoint, midpoint, and so on. Invoke the Snaps tool from the Settings 

panel; the Snaps dialog box will be displayed, as shown in Figure 2-5. This dialog box has 
three areas: Dimension Snaps, Object Snaps, and Temporary Overrides. These areas are 
discussed next.

Note
The settings in the Snaps dialog box apply to all the projects opened in the session and are not 
saved in a particular project. 

Dimension Snaps Area
In this area, you can set increments for placing elements or components in a project view. 
You can set increments for the length and angle dimensions. To set the increment of length 
dimension, select the Length dimension snap increments check box if it is not selected by 
default, and then enter the increment values in the edit box below it. The default values entered 
in this edit box are: 4’; 0’6”;0’1”; 0’1/4”;. Note that every incremental value is separated by 
a semicolon (;). You can also set increments by typing the values separated by a semicolon. 
For example, to create an interior layout plan in which the length of the partitions is in 5’ 
modules, counter top width is 2’, and the thickness of partitions is 4”, you can enter the values 
for the dimension snaps as 5’; 2’;4”. This will enable the cursor to move in these increments 
and help create the layout with relative ease.

In the Dimension Snaps area, snap increments for angular dimensions can be set by selecting 
the Angular dimension snap increments check box and then entering suitable values in the 
edit box below this check box. This setting is quite useful for projects that have radial geometry. 

Object Snaps Area
In the Object Snaps area, you can specify various object snaps for using them in a project. 
Object snapping refers to the cursor’s ability to snap to geometric points on an element 
such as endpoints, midpoint, perpendicular, and so on. It is useful for creating and editing 
elements. The advantage of using object snapping is that you can locate an appropriate point 

Ribbon:		 Manage > Settings > Snaps

Tip: The values that you will enter for dimension snapping should be set based on the 
scale and the amount of detailing required for the project. You may set smaller increments 
for working on a detail or a small portion of a building.
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on a drawing object. When enabled, the appropriate object snap is displayed as soon as the 
cursor is near to an element. For example, it is virtually impossible to pick the exact endpoint 
to start a wall from an endpoint of an already drawn wall. But when you enable the Endpoints 
object snap, the cursor automatically jumps or snaps to the endpoint of this wall. This helps to 
start the new wall from the endpoint. This, besides making the drawing accurate, later helps 
in adding dimensions to the project.

Note
The object snapping works only with the objects that are visible on the screen. A tooltip, with the 
same name as the object snap, is also displayed when you bring the cursor close to snap point.  

Various object snaps modes available in the Object Snaps area are: Endpoints, Midpoints, 
Nearest, Work Plane Grid, Quadrants, Intersections, Centers, Perpendicular, Tangents, 
Points, Snap to Remote Objects, and Snap to Point Clouds.

The use of each object snap corresponds to its respective name. The Work Plane Grid snap  
option enables you to snap to a point on a reference plane already defined in the model. For 

Figure 2-5  The Snaps dialog box
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example, you can place a furniture component exactly on the floor by snapping to the floor 
level reference plane. You can snap to the object that is closest to the cursor using the Snap to 
Remote Objects option. You can also snap points of a point cloud data object by selecting the 
Snap to Point Clouds check box. Each object snap mode has a geometrical shaped marker to 
identify it from the other object snaps. For example, the endpoint object snap is indicated by 
a square, midpoint by a triangle, nearest by a cross, and so on. To use an object snap mode, 
move the cursor over the object. You will notice a marker that appears as you move it close to 
the snap point. To select the appropriate snap point, click when the corresponding marker 
or tooltip is displayed. 

In Revit Architecture, all the enabled object snaps work simultaneously. You can turn off all 
the snap options including the dimension snaps and object snaps by checking the Snaps Off 
check box located at the top of the Snaps dialog box. Alternatively, you can type SO on the 
keyboard to turn them off and on while using a tool. The Check All and Check None buttons 
can be used to enable or disable the object snaps, respectively.

Temporary Overrides Area
The Temporary Overrides options provide you the alternative of overriding snaps setting 
for a single use only. For example, if you have not selected the Endpoints object snap in the 
Snaps dialog box and you want to use this option while working with a tool, you need not 
open the Snaps dialog box and set this option. Instead, you can type the shortcut, SE in this 
case, to temporarily activate the endpoint object snap. Once you have used this object snap 
option, snapping to the endpoint is automatically turned off.

You can toggle between various object snap options available at the same location using the 
TAB key on the keyboard. Hold down the SHIFT key to create the elements vertically or 
horizontally. This restricts the movement of the cursor in the orthogonal directions only. Once 
you release the SHIFT key, the cursor resumes its movement in all directions. You can select 
the Snaps Off check box to disable all types of snapping.

Saving a project
You must save your work before closing a project or exiting a Revit Architecture session. You 
have the option of saving the project file in a permanent storage device, which may be a hard 
disk or a removable disk. Also, you must save your work at regular intervals to avoid loss due 
to any error in the computer’s hardware or software. 

Saving the Project File

To save the project file to the desired location, click the Application Button and then choose 
Save As > Project from the Application Menu; the Save As dialog box will be displayed, as 

Tip: The Snaps tool is frequently used not only while creating various building elements 
but also while editing and placing them. By using this feature efficiently, you can improve 
the performance and accuracy of your project besides making modeling much simpler.

Application Menu: 	 Save As > Project    
Shortcut keys: 		 CTRL+S                 
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shown in Figure 2-6. Alternatively, you can save the project file by choosing the Save button 
from the Quick Access Toolbar.  

In the Save As dialog box, the Save in drop-down list displays the current drive and path in 
which the project file will be saved. The list box below the Save in drop-down list shows all 
folders available in the current directory. The File name edit box can be used to enter the 
name of the file to be assigned to the project. The Places List area in the left of the Save As 
dialog box contains shortcuts for the folders that are frequently used. 

Using the Options Button
You can use different features for saving a file by choosing the Options button from the Save 
As dialog box. On choosing this button, the File Save Options dialog box will be displayed, 
as shown in Figure 2-7. Using the Maximum backups edit box from this dialog box, you can 
specify the maximum number of backup files that you need to store for the project. In Autodesk 
Revit Architecture, the non-workshared projects have three backup files and the workshared 
projects have twenty backup files, by default. The options in the Preview area enable you to 
specify the image to be used as the preview of the project file. This image is used at the time 
of opening a project file. You can specify the view of the model to be used as a preview image 
from the Source drop-down list in the Preview area of the File Save Options dialog box.

The Active view/sheet is the default option for previewing a project file. For example, to make 
the Floor Plan: Level 1 the preview image, select it from the drop-down list. Whenever you 
select this project file, the preview will always show the Floor Plan: Level 1, irrespective of 
the last active view.

Figure 2-6  The Save As dialog box

Tip: The selection of large number of backup files for storing may use a lot of resources 
on the hard disk.  
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Select the Regenerate if view/sheet is not up-to-date check box to see the preview with the 
latest modifications. Selecting this check box will update the preview image on closing the 
project file.  

Note
Revit Architecture updates the preview image continuously. Therefore, selecting the Regenerate 
if view/sheet is not up-to-date check box can consume considerable resources.

Using the Save Tool
Once the project is saved using the Save As tool, you do not need to re-enter the file 
parameters to save it again. To save a project to the hard disk, click the Application 
button and then choose the Save option from the Application Menu, as shown 

in Figure 2-8. While saving the project for the first time, the Save As dialog box is displayed, 
even if you invoke the Save tool. Alternatively, you can save your project by choosing the 
Save button from the Quick Access Toolbar. As you save your project file, Revit Architecture 
updates it automatically without prompting you to re-enter the file name and path. 

configuring global settings
In Autodesk Revit Architecture, you can configure global settings by using 
the Options dialog box. This dialog box can be invoked by choosing the Options 
button from the Application Menu. The Options dialog box, as shown in Figure 2-9, 
contains nine tabs: General, User Interface, Graphics, File Locations, Rendering, Spelling, 
SteeringWheels, ViewCube, and Macros. The options of these tabs are discussed next.
  

Tip: The Preview image acts as a thumbnail to identify a project file. You must select 
a view that will help you identify the project file easily. 

Figure 2-7  The File Save Options dialog box 
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General Tab
The General tab is chosen by default in the Options dialog box. This tab contains four areas: 
Notifications, Username, Journal File Cleanup, and Worksharing Update Frequency; refer 
to Figure 2-9. These areas are discussed next.

Notifications Area
Revit Architecture provides you the option of setting reminders to save work at regular intervals. 
You can do so by setting options in the Notifications area. In this area, you can set the time 
interval at which Revit Architecture will remind you to save the project file. The default value 
for the Save reminder interval parameter is 30 minutes. You can specify the time interval by 
clicking on the down-arrow key and selecting the interval from the drop-down list. If you do not 
want a reminder, you can select the No reminders option from the drop-down list. Similarly, 
you can set the value for the Synchronize with Central reminder interval parameter.

Figure 2-8  Choosing the Save tool from the Application Menu

Figure 2-9  Setting the file options using the Options dialog box
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Username Area 
In Autodesk Revit Architecture, you can create a unique identification name for a particular 
session. To do so, enter a name in the edit box that is displayed in the Username area of the 
General tab. The name that you will enter in this edit box will be used for editing permissions 
in a multi-user Revit Architecture environment.

Note
When you run Autodesk Revit Architecture in your system for the first time, you will notice that 
the Windows login name is displayed as the default username in the edit box in the Username 
area. 

Journal File Cleanup Area
Journal files are the text files that are used to resolve technical problems that may occur during 
the Revit Architecture session and they record every step during the session. Whenever you 
encounter any technical problem with the software, you can run this file to detect the problem 
as well as recover the lost files or steps that had caused the problem. In Autodesk Revit 
Architecture 2012, these files are saved in the following default location: C:\Users\<Username>\
AppData\Local\Autodesk\Revit\Autodesk Revit Architecture 2012\Journals for Windows 7 or Window 
Vista users and C:\Documents and Settings\<Username>\Local Settings\Application for Windows 
XP users. These files are saved each time you close the Revit Architecture session. As such the 
quantity of these files keeps on increasing until you remove these files from their location. To 
retain certain files and clean others, you can use the Journal File Cleanup area in the General 
tab of the Options dialog box. This area contains two spinners: When number of journal 
exceeds then and Delete journals older than (days). You can set the required 	 values in 
these spinners to retain the files that are recently created. For example, if you need to delete 
journal files if their number exceeds 15 and if they were created before 30 days. Then, in such 
a situation, set the value in the When number of journal exceeds spinner to 15 and the value 
in the Delete journals older than (days) spinner to 30. 

Worksharing Update Frequency Area
In this area you can set the time interval for updating the project in a worksharing environment. 
To set the update frequency for worksharing, you can set the slider between Less Frequent 
and More Frequent. 

User Interface Tab
The User Interface tab contains three areas: Configure, Tab Display Behavior, and 
Tooltips. In the Configure area, you can specify the options for the display of Autodesk 
Revit Architecture user interface. You can do so by selecting the Dark or Light option from the 
Active theme drop-down list in this area. In this area, you can choose the Customize button 
corresponding to the Keyboard Shortcuts parameter to customize the use of shortcut keys in 
a project. In the Tab Display Behavior area, you can specify the tab to be displayed once you 
clear a selection or exit a tool. In this area, the In the project environment heading contains 
two radio buttons: Stay on the Modify tab and Return to the previous tab. Select the Stay on 
the Modify tab radio button to display the options in the Modify tab after exiting a tool or 
clearing a selection. Alternatively, you can select the Return to the previous tab radio button 
to display the last used tab after exiting a tool or clearing a selection. Similarly, you can use 
the settings in the In the family editor heading to specify the display behavior of the family 
editor mode. 
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In the Tab Display Behavior area, the Display the contextual tab on selection check box 
is selected by default. As a result, the contextual tab is displayed once you select a tool from 
the Revit interface.
    
In the User Interface tab, the tooltip assistance refers to a tip that is displayed with the 
cursor when it is close to a tool, snap, or an element. The display of this tip with the cursor  
can be set to a required level by selecting an appropriate option from the Tooltip assistance 
drop-down list in the Tooltips area. The options in this drop-down list are Normal, None, 
Minimal, and High. By default, the Normal option is selected in this drop-down list. Note 
that the tooltip will appear more frequently in your drawing if you select High in the Tooltip 
assistance drop-down list.  

Graphics Tab
The options in the Graphics tab enable you to configure the display card of your computer 
to improve the display performance. You can also use this tab to assign colors to selections, 
highlights and alerts, and enable anti-aliasing for 3D views. In the Graphics Mode area of 
this tab, the Use Hardware Acceleration check box is selected by default. As a result, the 
hardware accelerators are enabled. Hardware accelerators help display the larger models 
faster on refreshing the views. In addition, the hardware accelerators help you speed up the 
process of switching between the windows of views. In this area, you can select the Use-Anti 
Aliasing for 3D views check box to improve the quality of lines in 3D views. In the Colors 
area of the Graphics tab, select the Invert background color check box to toggle the color 
of the background and elements. The Selection parameter refers to a color that an element 
acquires when it is selected. The default color is RGB 000-059-189. To use any other color, click 
the button on the right of the Selection parameter and select the desired color from the Color 
dialog box. The Pre-selection parameter refers to the color of the highlighted elements. To use 
any other color, click the button on the right of the Selection parameter and select the desired 
color from the Color dialog box. Revit Architecture uses the Alert button to highlight elements 
when an error occurs. In the Colors area, you can select the Semi-transparent check box to 
make the selected elements semi-transparent. As a result you can view the elements behind 
the selection. In the Temporary Dimension Text Appearance area, you can select an option 
from the Size drop-down list to specify the size of the text used in temporary dimensions. In 
this area, you can set the background of the text in the temporary dimensions. To do so, select 
the Opaque or Transparent option from the Background drop-down list.

File Locations Tab
The options in the File Locations tab can be used to set the path for the template files, user 
files, and family template files that are accessed frequently. Figure 2-10 shows various options 
in this tab. The path for these files is set at the time of installing Revit Architecture. However,  
you can modify the location by choosing the corresponding Browse button and specifying a 
new path. The default template file location can be changed, in case you wish to use a custom 
made template file for your projects. Revit Architecture uses the default path for user files for 
saving or opening a project. You can also specify the default path for family template files and 
for the point clouds by using the corresponding Browse button.
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Rendering Tab
In Autodesk Revit Architecture, in addition to the default Render Appearance Library location, 
you can also specify the paths for the additional image files defining texture, bump map, 
custom color for the render appearance that you can use in the project. These image files are 
not present with the software and therefore, you need to specify their paths to use them. To 
do so, choose the Add Value button in the Additional Render Appearance Paths area and 
specify the required path in the displayed field or choose the Browse button; the Browse for 
Folder dialog box will be displayed. In this dialog box, select the desired path and choose the 
Open button to add the path in the field.

Spelling Tab 
Revit Architecture provides you the option to run spell check to find spelling errors in the 
text and then rectify them. You can choose the Spelling tab to display its options. Various 
self-explanatory settings can be selected from the Settings list. In the Main Dictionary area 
of this tab, you can select the type of dictionary, to be used as main dictionary for the spelling 
check from the Autodesk Revit drop-down list.  Apart from the main dictionary, you can also use 
additional dictionaries such as the personal and building industry dictionaries. This facilitates 
the use of various personal and industry related terms in the text matter of the project. There 
are many words that are not included in the main dictionaries but are frequently used in the 
building industry. For example, the abbreviation for concrete ‘conc’ is not available in the main 
dictionaries. The additional building industry dictionary has many such words and abbreviations 
that can be used in the text matter of the project without being prompted for errors while 
checking spellings. You can also add or remove words from your personal and building industry 
dictionary. Choose any of the Edit buttons available in the Additional Dictionaries area to 
view the list of words. You can enter or remove any word from these lists using the cursor and 
keyboard.  To run spell check in your drawing, choose the Spelling  tool from the Text panel in 
the Annotate tab; the  Spelling dialog box will be displayed, wherein you can rectify the spelling 
errors in the text by selecting the correct spelling and then choosing the Change button in 
the dialog box, as shown in Figure 2-11. Alternatively, you can press the F7 key to display the 
Spelling dialog box, refer to Figure 2-11, and then make necessary corrections in the text.

Figure 2-10  Various options in the File Locations tab 
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SteeringWheels Tab
The options in the SteeringWheels tab in the Options dialog box are used to control the 
visibility, appearance, and operational tools of different types of SteeringWheels. This tab has 
seven different areas of control to use the SteeringWheels, as shown in Figure 2-12. These 
areas are discussed next.  
 
Text Visibility Area
You can control the display of tool messages, tooltips, and tool cursor of the SteeringWheels 
by using the options in the Text Visibility area of the SteeringWheels tab. In this area, the 
Show tool messages check box is selected by default. As a result, the visibility of tool messages 
in SteeringWheels is enabled. To display the tooltips along with the SteeringWheels, select the 
Show tooltips check box in this area. Similarly, to control the display of the cursor text when 
a tool is active, use the Show tool cursor text check box. Select this check box to display the 
cursor text when the tool is active. 

Big Steering Wheel Appearance and Mini Wheel Appearance Areas
To set the size of the SteeringWheels, select the required option from the Size drop-down list 
in the corresponding areas and set its size to small, normal, or large. Similarly, you can set 
the transparency of the SteeringWheels by selecting the required option from the Opacity 
drop-down list.

Look Tool Behavior and Walk Tool Areas
In the Look Tool Behavior area of the SteeringWheels tab, select the Invert vertical axis 
check box to change the movement of the view along the vertical axis while using the Look 
tool. Note that on selecting the check box, the view will move in the same direction as that 
of the cursor.

In the Walk Tool area of the SteeringWheels tab, use the Speed Factor slider to change the 
speed of the walk while using the Walk tool of the SteeringWheels. Select the Move parallel 
to ground plane check box if it is not selected by default, to constrain the movement angle 
of the walk to ground plane.

Figure 2-11  The Spelling dialog box
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Zoom Tool and Orbit Tool Areas
Select the Zoom in one increment with each mouse click check box in the Zoom Tool area to 
enable the zooming operation with a single click. In the Orbit Tool area, ensure that the Keep 
scene upright check box is selected. This helps maintaining the perpendicularity between 
the sides of the model and the ground plane while using the Orbit tool. 

ViewCube Tab  
The options in the ViewCube tab in the Options dialog box are used to edit various settings 
of the ViewCube. It has four different areas to modify the ViewCube: ViewCube Appearance, 
When Dragging the ViewCube, When Clicking on the ViewCube, and Compass, as shown 
in Figure 2-13. These areas are discussed next.

ViewCube Appearance Area 
The appearance and display of the ViewCube can be controlled by the ViewCube Appearance 
area in the ViewCube tab.

In the ViewCube Appearance area, the Show the ViewCube check box is selected by default, 
so the ViewCube will be visible. If you clear this check box, the ViewCube will disappear and 
all options in the ViewCube tab will be deactivated.

Figure 2-12  The SteeringWheels tab of the Options dialog box
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In the ViewCube Appearance area, you can use various drop-down lists to align, resize, 
and change the transparency of the ViewCube. You can select an option from the Show in 
drop-down list to specify whether the ViewCube will be displayed in all 3D views or only in 
the active view. The On-screen position drop-down list is used to position the ViewCube 
on the screen. Similarly, you can resize the ViewCube by selecting the required option from 
the ViewCube size drop-down list. You can also set the opacity of the inactive ViewCube by 
selecting various options from the Inactive Opacity drop-down list.

When Dragging the ViewCube Area  
In this area, the Snap to closest view check box is selected by default. As a result, the closest 
ViewCube view orientation will be snapped.

When Clicking on the ViewCube Area
Select the Fit-to-view on view change check box in the When Clicking on the ViewCube area 
to fit the view on screen while changing the viewing direction. The Use animated transition 
on switching views check box is selected by default in this area that enables the view to change 
in animation. Clearing this check box will result in the change of view without any animation, 
when using the ViewCube. Select the Keep scene upright check box to keep the sides of the 
ViewCube and the sides of the view perpendicular to the ground plane. Clear the check box 
to turn around the model in full 360-degree swing. Clearing this check box can be useful 
when you are editing a family.

Figure 2-13   The ViewCube tab of the Options dialog box
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Compass Area
The Show the compass with the ViewCube check box in the Compass area is selected by 
default. As a result, the compass along with the ViewCube will be visible in the drawing. 

In the ViewCube tab, you can choose the Restore Defaults button to restore the default settings 
that were changed in its different areas.
  

Closing a project
To close a project, choose the Application Button and then select the Close 
option from the Application Menu displayed, as shown in Figure 2-14. If you 
have already saved the latest changes, the project file will be closed. Otherwise, 
Revit Architecture will prompt you to save the changes through the Save File 
confirmation box. You can save the changes by choosing the Yes button or 
discard them by choosing the No button. You can also choose the Cancel button 
to return to the interface and continue working on the project file. You can 
also use the Close button (X) in the drawing window to close the project.

EXITING A PROJECT
To exit a Revit Architecture session, choose the Exit Revit button from the Application 
Menu. Even if the project is open, you can still choose the Exit Revit button to close the file 
and exit Revit Architecture. In case, the project has not been saved, it enables you to save the 
work through the Save File window, as shown in Figure 2-15. If you choose the No button, 
all changes that were not saved will be lost. You can also use the Close button (X) of the main 
Revit Architecture window (in the title bar) to end the Revit Architecture session.

Opening an existing project
To open an existing project in Revit Architecture, you can use various options in it, such as 
the Open tool or the Windows explorer. These options are discussed in detail in the next 
section.

Opening an Existing Project Using the Open Tool     

To open an existing project file, choose Open > Project from the Application Menu, 
as shown in Figure 2-16. Alternatively, you can open a project by choosing the Open 

Figure 2-14  
Choosing the 
Close option 

Application Menu:       Open > Project
Shortcut Keys:	            CTRL+O

Figure 2-15  The Save File window
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button from the Quick Access Toolbar or by pressing CTRL+O. On doing so, the Open 
dialog box will be displayed, as shown in Figure 2-17. In this dialog box, you can open a 
particular project file by accessing the appropriate folder using the Look in drop-down list. 
The Preview area of the Open dialog box shows the preview of the selected project file. It 
helps you select a particular file by viewing its contents, even if you are not sure about the file 
name. The window icons such as the Views menu, placed along with the Look in drop-down 
list, help you select a project file based on its size, type, and the date when it was last saved. 
On choosing the Thumbnails option from the Views menu, you can preview the contents of 
the project files inside the selected folder in the file list area, as shown in Figure 2-18. The 
Places list is located on the left in the Open dialog box. You can add or remove folders from 
the Places list by choosing the Options button from the Application Menu. On doing so, 
the Options dialog box will be displayed. Choose the File Locations tab from the dialog box, 
and then choose the Places button from it; the Places dialog box will be displayed, as shown 
in Figure 2-19.

Figure 2-16  Choosing the Project option 
from the Application Menu

Tip: You must be cautious while choosing the No button in the Save File confirmation 
box because it discards all the changes made in the project since the last save.

Figure 2-17  The Open dialog box
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The Places dialog box contains two columns: Library Name and Library Path. You can add 
or remove folders in the libraries list to create a list of frequently accessed folders. The four 
buttons on the left of the Places dialog box can be used to create or delete a library, or move 
it up and down in the list. To create a new library, choose the Add Value button, which is the 
third button from the top; a new library will be added to the defined path. By default, the name 

Figure 2-19  The Places dialog box

Tip: By default, the preview of a file is the last active view or sheet at the time it was last 
saved. You can set the preview to a particular view by using the Options button in the 
Save As dialog box. 

Figure 2-18  Previewing the contents inside the file using the Thumbnails option
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of the new library in the Library Name section will be NewLibrary1. Change the name of the 
new library and then click in the Library Path column to display the browse button. Choose 
the browse button and select the folder to be added in the libraries list using the Browse for 
Folder dialog box. Choose the Open button after selecting the folder; the new folder gets 
added to the list. If required choose the upward arrow button in the Places dialog box to move 
the folder up to the top of the list. Similarly, you can choose the down arrow button to move 
it down. To delete any library, select the library and choose the RemoveValue button. Choose 
the OK button in the Places dialog box to exit, and then close the Options dialog box. When 
you invoke the Open tool next time, the new folder icon will be displayed in the places list. 

Once the file to be opened has been selected, its name will be displayed in the File Name edit 
box of the Open dialog box and its preview will be displayed in the Preview area.

Note
If you try opening an already opened file, which has been modified in the Revit Architecture 
session, a message box appears, prompting you to close the file first and reopen it. In case you 
open a file that has been created using an older version of Revit, the Program Upgrade 
message box is displayed. It mentions that the file is being upgraded to the latest file format 
and that this is a onetime process. Once the file is opened, it gets upgraded to Autodesk Revit 
Architecture 2012 version.

Using the Windows Explorer to Open an Existing Project
Apart from using the Open tool from the Revit Architecture interface, you can also open files 
directly from the Windows Explorer by using the methods discussed next.

A file can be opened by double-clicking on its icon in the Windows Explorer. It opens 
the project file in the latest Revit Architecture session. If Revit Architecture is not running, 
double-click on the file icon to start Revit Architecture and then open the file. Another method 
of opening a project file is by dragging the project file icon from the Windows Explorer and 
dropping it into the drawing window of the Revit Architecture interface. You can also select, 
drag, and drop more than one file in the drawing window. In this case, Revit Architecture 
prompts you to open the files in separate windows. Choose the OK button to open all files in 
the same Revit Architecture session.

Model display tools
As described earlier, in Revit Architecture, you can create the building model using the 
3D parametric elements. Various tools are provided to view the building model. Based 
on the requirement, you can use these tools to navigate and edit elements in the building 
model.

Using the Zoom Tools
The Zoom tools are used to enlarge or reduce a project view in the viewing area. To use these 
tools, you need to display the Navigation Bar in your drawing. Generally, the Navigation Bar 

Tip: When you rest the cursor on the project file name, a tooltip appears, which provides 
you the information regarding the type and size of the project file.
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Window panel of the View tab; a drop-down menu will be displayed, as shown in Figure 2-20. 
In the drop-down menu, select the Navigation Bar check box; the Navigation Bar will be 
displayed in the viewing area. In the Navigation Bar, click on the down arrow below the Zoom 
All to Fit tool; a cascading menu will be displayed, as shown in Figure 2-21. This cascading 
menu displays different zooming options, which are discussed next. 

Zoom In Region
This tool is used to zoom into a specified area or window. When you invoke the Zoom In 
Region tool from the Navigation Bar, the cursor is replaced by a magnifying glass. To 

zoom into an area, you need to define a rectangular window by picking its diagonally opposite 
corners. You can click at a point to specify the start point of the window. When you move the 
cursor, a dynamic rectangular window is created whose one corner is the specified point and 
the other corner is attached to the cursor. Move the cursor across the area you want to enlarge. 
When the area is enclosed in the rectangle, click to specify the diagonally opposite corners of 
the zoom window. The specified portion of the current view is enlarged. For example, to work 
on the stairs of a building plan, you can invoke the Zoom In Region tool and click to specify 
the two opposite corners of the window, as shown in Figure 2-22. The resulting enlarged view 
is shown in Figure 2-23.

Zoom Out(2X)
This tool is used to zoom out of the existing view by twice the size of the current view. 
This means, when you invoke this tool, the new view will show twice the length and 

width of the original view. 

Tip: The names of the recently opened files are displayed in the Application Menu. 
On starting Revit Architecture, you can click on the name of the project file that you 
wish to open.

Figure 2-20  A drop-down menu displayed on 
choosing the User Interface drop-down

Figure 2-21  Different zooming options in 
the cascading menu
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Zoom To Fit and Zoom All to Fit
The Zoom To Fit tool is used to display all the contents of the project in the current 
view. On invoking this tool, the drawing window will adjust to show all the elements that 

have been created in a view. If there are multiple windows open with different zoom factors, 
invoke the Zoom All to Fit tool to perform Zoom To Fit in all the windows.

Zoom Sheet Size
The Zoom Sheet Size tool is used to fit the drawings in the default sheet size displayed 
in the Paper tab of the printer’s Properties dialog box. This dialog box will be displayed 

on choosing the Properties button in the Print dialog box. 

Previous Pan/Zoom and Next Pan/Zoom 
The Previous Pan/Zoom tool reverts back to the last displayed view using zoom or pan, whereas 
the Next Pan/Zoom tool is a toggle tool to show the next displayed view. 

Using the Orient Options
In Revit Architecture, you can view a building model in 3D from the preset viewpoints using 
the Orient options.
 
To use the Orient options, activate the 3D view by choosing the Default 3D View tool 
from View > Create > 3D View drop-down. Alternatively, you can activate the 3D view by 
double-clicking on {3D} under the 3D Views head in the Project Browser. On doing so, 
the current view will orient to the default 3D view along with the ViewCube displayed at 
the upper-right corner of the drawing area. Now, place the cursor over the ViewCube and 
right-click; a shortcut menu will be displayed, as shown in Figure 2-24. Now, in the shortcut 
menu, click on the Orient to a Direction option; a cascading menu will be displayed, as shown 
in Figure 2-25. From this cascading menu, select the appropriate view that will be displayed 
in the drawing window.

Figure 2-23  The resulting enlarged viewFigure 2-22  Specifying the corners 
of the zoom window

Start 
point

Endpoint
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Navigation Tools
Navigation tools in Revit, help you navigate and maneuver into your model in different directions 
and views. The two navigation tools, SteeringWheels and ViewCube, are discussed next.

ViewCube
The ViewCube tool is an interactive 3D navigation tool that appears in all 3D views of a Revit 
project. By default, the ViewCube tool is visible at the top right corner of your drawing 
area.

The ViewCube navigation tool comprises of a cube, a compass ring at the base with various 
directions marked on it, and a home icon that helps you set the default view, as shown in 
Figure 2-26. The ViewCube navigation tool is displayed in your drawing area either in the 
active or inactive state, as shown in Figures 2-27 and 2-28. By default, the ViewCube is in 
its inactive state and it appears partially transparent over your drawing area. Therefore it 
prevents the obstruction of the view of your model. Whereas, in its active state, the ViewCube 
appears opaque and distinct and obstructs the view of your model. You can change the size, 
on-screen placement, visibility of the compass, and the inactive opacity of the ViewCube as 
per your requirement. To do so, choose the ViewCube tab from the Options dialog box as 
discussed earlier. 

Figure 2-24  Options in the shortcut 
menu of the ViewCube

Figure 2-25  Options in the cascading 
menu of the Orient to a Direction tool

Figure 2-27  The ViewCube in the active stateFigure 2-26  The ViewCube and its various 
components
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In the ViewCube tool, there are twenty-six defined areas comprising faces, edges, and corners.  
The twenty-six defined areas can be divided into three categories, corner, edge, and face, as 
shown in Figure 2-29. Out of the twenty-six defined areas, six areas represent the standard 
orthographic views of a model such as top, bottom, front, back, left, and right. The standard 
orthographic views are set by clicking on one of the faces on the ViewCube. The other twenty 
areas are defined to access the angular views of a model.

When you move the cursor on the faces, edges, or vertices of an active ViewCube, the 
corresponding area gets highlighted in dark-gray color. These highlighted regions are called 
hotspots. While using the ViewCube, you can click on these hotspots to orient your view as 
per your requirement.

SteeringWheels  
The SteeringWheels navigation tools are tracking menus that comprise of multiple navigation 
features in a single interface. Using the features in these tools, you can pan, zoom, walk, 
look, and adjust the view of your model as per your requirement. The SteeringWheels tool 
is divided into different sections known as wedges. Each wedge represents a unique function 
for navigation.

To activate the SteeringWheels navigation tool in your model, press the F8 key. The 
SteeringWheels tool will appear according to the state of view in which you are working. If 
you are currently working in a 2D view, you can use the 2D SteeringWheels tool. Similarly, 
you can use the 3D SteeringWheels tool when you are working in the 3D view.

In Revit, you can access various types of SteeringWheels from the Navigation Bar. In 
the Navigation Bar, click on the down arrow below the default Full Navigation Wheel 
tool; a shortcut menu with various types of Steering Wheels will be displayed, as shown 
in Figure 2-30.
  
To navigate the 2D view, you can use the 2D navigation wheel, as shown in Figure 2-31. The 
2D navigation wheel has three navigation tools, Zoom, Pan, and Rewind. Zoom is a common 
navigation tool for enlarging or reducing the viewing scale of the model. You can use the Pan 
tool for traversing across the model view. The Rewind tool can be used to see the views of 
the previous zooming states which are saved temporarily.

Figure 2-28  The ViewCube in the inactive 
state 

Figure 2-29  Different areas on the ViewCube
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The 3D SteeringWheels navigation tools help you navigate through your 3D views. Based 
on the size and appearance, the 3D SteeringWheels is categorized into two groups, Mini 
Steering Wheels and Big SteeringWheels. 

The Mini SteeringWheels are classified into three types, Mini View Object Wheel, Mini Tour 
Building Wheel, and Mini Full Navigation Wheel, as shown in Figure 2-32.

The Mini View Object Wheel has four distinct navigation tools, Pan, Zoom, Rewind, and Orbit. 
Similarly, the Mini Tour Building Wheel comprises of four unique navigation options, Up/
Down, Look, Walk, and Rewind. The Full Navigation Wheel comprises of eight wedges 
with each wedge defining a unique navigation function. The Mini Full Navigation Wheel 
combines all the functions of the Mini View Object Wheel and Mini Tour Building Wheel.
The Big SteeringWheels has the similar classification as that of the Mini SteeringWheels, as 
shown in Figure 2-33, and it has the same navigation tools as that of the Mini SteeringWheels 
with the only difference in their appearances on screen.

As you put your cursor over any of the navigation tools, the tooltips and messages are 
displayed, as shown in Figure 2-34. The tooltips inform you regarding the tool that you want 
to use and provide instruction for using it. You can control the visibility of the tooltips and the 
tool messages while using the SteeringWheels by using the Options dialog box, as discussed 
earlier in this chapter.  

While using the SteeringWheels navigation tool, you can activate the available navigation tools 
by clicking and holding the left mouse button over any one of the wedges. After holding the 
left mouse button and dragging it over the drawing area, you can use the selected navigation 

Figure 2-32  Types of Mini SteeringWheels for 3D Views

Figure 2-31  The 2D Steering 
Wheels navigation tool

Figure 2-30  Shortcut menu displaying 
various types of SteeringWheels
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tool for reorienting your view. Now, to exit the selected navigation tool, release the left 
mouse button.

Other Display Options 
Revit Architecture provides five options to view the building model in different modes of 
shading. You can select these options by clicking on the Visual Style button from the View 
Control Bar and then selecting the desired option from the shortcut menu that will be 
displayed. There are five options that are available in the shortcut menu and are described 
next.

Figure 2-33  Appearance of Big SteeringWheels 

Figure 2-34  Appearance of the tooltip with 
the SteeringWheels
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Wireframe 	         :	 Displays the model with all lines and edges without surfaces.

Hidden Line 	         :	 Displays the model with lines and edges that are visible.

Shaded 	         :	 Displays the building model with the surfaces shaded with respect  	
			   to the material shading and default lighting effect.

Consistent Colors     :	 Displays the building model in different consistent colors, making
			   the model more aesthetic.

Realistic                    :	 Displays the model in single color with no boundaries and edges  
			   demarcated.

Note
By default, these options affect the current view only. However, you can save the shading effects 
by saving the shaded view in the project file.

Tutorials 
In the tutorials of this chapter, you will start two projects: an apartment complex and a 
club building. However in the subsequent chapters of this textbook, some portions of these 
two projects will be completed in tutorials and the rest will given as exercises and need to 
be completed. The tutorials and exercises form a sequence, and therefore, to complete these 
projects, you need to complete both the tutorials and exercises in the previous chapters. The 
following tutorials will familiarize you with the tools and concepts discussed in this chapter 
such as starting Revit Architecture, opening a new project, setting units, setting snaps, saving 
and closing the project.

In this tutorial, you will create a new project file for the Apartment 1 project with the following 
parameters.							         (Expected time: 15 min)

1.	 Template file - default.rte.
2.	 Project Units- Feet and fractional inches, Rounding- To the nearest 1/2”.
3.	 Length dimension snap increment- 5’ ;2’6”; 3”; 0’1/2”.
4.	 File name to be assigned- c02_Apartment1_tut1.rvt

	 The following steps are required to complete this tutorial:

a. 	 Start a Revit Architecture session.
b.	 Use default.rte as the template file for the project, refer to Figure 2-35. 
c.	 Set Feet and fractional inches as the project units using the Project Units dialog box, 

refer to Figure 2-36.
d.	 Set 5’; 2’6” ;3”; 0’1/2” as the length dimension snap increment using the Snaps dialog 

box.
e.	 Set Endpoint, Midpoint, Nearest, Perpendicular, Work Plane Grid, Snap to Remote 

Objects, and Intersection as the object snaps in the Snaps dialog box.

Tutorial 1					                       Apartment 1
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f.	 Save the project as c02_Apartment1_tut1.rvt using the Save As tool, refer to Figure 2-37.
g.	 Close the project using the Close tool.

Starting Autodesk Revit Architecture 2012
1.	 Start Revit Architecture by choosing Start > Programs > Autodesk > Autodesk Revit 

Architecture 2012 > Autodesk Revit Architecture 2012. The program is loaded and the 
user interface screen is displayed.

Opening a New Project 
1.	 Click on the Application button; the Application Menu is displayed. Choose 

New > Project from this menu; the New Project dialog box is displayed. 

Using the Template File
	 To use the template file for the project, you need to access the appropriate folder and 

then select the required template file.

1.	 In the New Project dialog box, choose the Browse button from the Template file area; 
the Choose Template dialog box is displayed, showing a list of the template files available 
in the Imperial Templates folder.

2.	 In the Choose Template dialog box, the default.rte template file is selected by default, as 
shown in Figure 2-35 . Choose the Open button to close the Choose Template dialog box 
and to assign the selected template file to the New Project dialog box.

Figure 2-35  The Choose Template dialog box with the default.rte file selected
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3.	 Ensure that the Project radio button is selected in the New Project dialog box. Next, 
choose the OK button from the dialog box; the default.rte template file is loaded. Notice 
that the Project Browser now shows different levels and views that have already been 
created in the selected template file.

Setting Units
1.	 To set units for the project, choose the Project Units tool from the Settings panel of the 

Manage tab; the Project Units dialog box is displayed. 

2.	 Click in the Format column next to the Length parameter; the Format dialog box is 
displayed. 

3.	 In the Format dialog box, select the Feet and fractional inches option from the Units 
drop-down list, if it is not selected by default.

4. 	 Click on the Rounding drop-down list in this dialog box and select the To the nearest 
1/2” option, as shown in Figure 2-36.

5.	 Choose the OK button; the Project Units dialog box is displayed. Again, choose the OK 
button to apply the specified units and to exit the dialog box. 

Setting the Dimension and Object Snaps
	 To set the dimension and object snaps, use the Snaps tool. These settings are made based 

on the type of the project and the amount of detailing required.

1.	 Choose the Snaps tool from the Settings panel of the Manage tab; the Snaps dialog 
box is displayed. In the Length dimension snap increments edit box, enter 5’;2’6”;3”; 
0’1/2”;. 

Figure 2-36  Selecting the To the nearest 1/2” option in the Format dialog box
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2.	 In the Object Snaps area, clear the Quadrants, Centers, Tangents, and Points 
check boxes. Leave the other check boxes selected. Choose the OK button to 
apply the settings and exit the Snaps dialog box.

Saving the Project
	 The project parameters set in the previous steps are an integral part of the project file. 

To save this project file with these settings, use the Save tool.

1.	 To save the project, choose the Save option from the Application Menu. As you are saving 
the project for the first time, the Save As dialog box is displayed. 

2.	 In this dialog box, browse to the C drive and then create a folder with the name 
revit_architecture_2012.

 
3.	 Open the revit_architecture_2012 folder and then create a sub-folder with the name c02. 

Next, open the created folder and save the file with the name c02_Apartment1_tut1.rvt, as 
shown in Figure 2-37.

Closing the Project
1. 	 To close the project, choose the Close option from Application Menu. As you have already 

saved the latest changes made to the project file, choose Close to close the project file. 

Figure 2-37  Saving the project using the Save As dialog box
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In this tutorial, you will create a new project file for the Club project using the following 
parameters.						                     (Expected time: 15 min)

1.	 Template file - Commercial-Default.rte.
2.	 Project Units- Feet and fractional inches.
3.	 Length dimension snap increment- 10’;2’6”;1’; 0’3”.
4.	 Object snaps to be set- all available object snaps.
5.	 File name to be assigned- c02_Club_tut2.rvt

	 The following steps are required to complete this tutorial:

a. 	 Start a Revit Architecture session.
b.	 Use Commercial-Default.rte as the template file by accessing the Imperial Templates 

folder. 
c.	 Set Feet and fractional inches as the project units using the Project Units dialog box.
d.	 Set 10’;2’6”;1’; 0’3” as the length dimension snap increment in the Snaps dialog box.
e.	 Select the To the nearest 1/4” option for rounding.
f.	 Enable all the object snaps using the Snaps dialog box.
g.	 Save the project as c02_Club_tut2.rvt using the Save As tool.
h.	 Close the project using the Close tool.

Starting Revit Architecture and Opening a New Project 
1. 	 Start a new Revit Architecture session by double-clicking on the Autodesk Revit 

Architecture 2012 shortcut icon on the desktop. On doing so, the user interface screen 
is displayed. In case, the Revit Architecture session is already running, this step can be 
ignored and the project file can be opened directly.

2.	 Choose New > Project from the Application Menu; the New Project dialog box is 
displayed.

Using the Template File
	 As given in the project parameters, you need to use the Commercial-Default.rte template 

file for this project. Select this template file from the New Project dialog box.
	
1.	 In the New Project dialog box, choose the Browse button; the Choose Template dialog 

box is displayed. In this dialog box, select the Commercial-Default template file from the 
Imperial Templates folder and then choose Open; the selected template file is assigned 
to the project. Next, choose OK; the Commercial-Default.rte template file is loaded. 

	 Notice that the Project Browser now shows several levels that are preloaded in the template 
file.

Setting Units
	 You can set units for various measurement parameters using the Project Units dialog 

box.

Tutorial 2					                                      Club  
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1.	 Choose the Project Units tool from the Settings panel of the Manage tab; the Project 
Units dialog box is displayed. 

2.	 Click in the Format column next to the unit Length; the Format dialog box is displayed. 
In this dialog box, make sure that the Feet and fractional inches option (default option) 
is selected in the Units drop-down list.   

3.	 Next, select the To the nearest 1/4” option from the Rounding drop-down list. 

4.	 Choose OK to return to the Project Units dialog box. Next, choose the OK button to 
apply the settings and return to the user interface screen.

Setting Dimensions and Object Snaps
	 In this section of the tutorial, you need to access and modify the settings in the Snaps 

dialog box. Further, you need to specify the dimension snap increment and enable all 
object snap options. 	

1.	 Choose the Snaps tool from the Settings panel of the Manage tab; the Snaps dialog box 
is displayed. 

2.	 In the Object Snaps area, ensure that all the check boxes for snapping are selected.

3.	 In the Length dimension snap increments edit box, enter 10’;2’6”;1’; 0’3”; and then 
choose the OK button to apply the settings and exit the Snaps dialog box. 

Saving the Project
	 In this section, you will save the project and the settings using the Save As dialog box.
	
1.	 To save the project with the specified settings, choose Save As > Project from the 

Application Menu. As you are saving the project for the first time, the Save As dialog 
box is displayed. 

2.	 Browse to the c02 sub-folder in the revit_architecture_2012 folder and enter c02_Club_tut2 
in the File name edit box. Notice that the File of type drop-down list shows Project Files 
(*.rvt) as the default option. 

3.	 Choose the Save button to save the project with the name c02_Club_tut2.rvt. The project 
is saved at the specified location.

Closing the Project
1.	 To close the project, choose the Close option from Application Menu. 
	
	 The file is closed and this completes Tutorial 2 of Chapter 2.
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Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 You can open only one Revit Architecture project at a time. (T/F)

2.	 In Revit Architecture, all enabled object snaps work together. (T/F)

3.	 While saving a project file for the first time, the Save As dialog box is displayed on 
choosing the Save tool from the Application Menu. (T/F)

4.	 A project file can be opened by double-clicking on the file name in the Windows Explorer. 
(T/F)

5.	 You can save any project file as a template file. (T/F)

6.	 The keyboard shortcut for the Save tool is __________.

7.	 To specify the location of the default template file, you can use the __________ tab of the 
Options dialog box.

8.	 The __________ button in the Save As dialog box can be used to specify the maximum 
number of backup(s) for a project file.

9.	 The __________ option of Revit Architecture enables you to override the snap settings for 
a single pick only.

10.	 You can add folders to the __________ list in the Save As dialog box to access the frequently 
used folders directly.

Answer the following questions:

1.	 You can modify the project unit settings anytime during a project. (T/F)

2.	 The file name and path of a project have to be specified each time you save the project. 
(T/F)

3.	 You cannot control the visibility of the tooltip assistant. (T/F)

4.	 The Save reminder interval drop-down list available in the General tab of the Options 
dialog box is used to specify the time interval between the reminder prompts to save a 
project file. (T/F)

Review Questions

Self-Evaluation Test
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5.	 If the changes made to a project file have not been saved, Revit Architecture prompts you 
to save the changes when you choose the Close tool from the Application Menu. (T/F)

6.	 You can open only one project file at a time in a Revit Architecture session. (T/F)

7.	 You can add words to additional dictionaries for checking spellings. (T/F)

8.	 Which of the following is not an object snap option?

		  a) Endpoint				    b) Work Plane Grid
		  c) Dimension		  		  d) Centers

9.	 Which of the following keys can be used to toggle between the object snap options available 
at the same point? 

		  a) TAB					     b) CTRL
		  c) ALT					     d) F3

10.	 Which of the following shortcut keys is used to activate the SteeringWheels.

		  a) F2				                b) F6
		  c) CTRL                                                  d) F8
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Create a new project file for the Apartment2 project with the following parameters:
(Expected time: 15 min)

1.	 Template file - default.rte
2.	 Project Units- Feet and fractional inches
3.	 Length dimension snap increment- 5’;2’6”;3”; 0’1/2”
4.	 File name to be assigned- c02_Apartment2_ex1.rvt

Create a new project file for the Elevator and Stair Lobby project with the following 
 parameters:							         (Expected time: 15 min)

1.	 Template file - default.rte
2.	 Project Units- Feet and fractional inches
3.	 Length dimension snap increment- 5’;1’;3”; 0’1”
4.	 File name to be assigned- c02_ElevatorandStairLobby_ex2.rvt

Answers to Self-Evaluation Test
1. F, 2. T, 3. T, 4. T, 5. T, 6. CTRL+S, 7. File Locations, 8. Options, 9. Temporary Overrides, 
10. Places

Exercise 1			                                      Apartment 2

Exercises

Exercise 2                                ELevator and Stair Lobby


